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ABSTRACT

This document outlines the basic hardware and software components for the BOOSTXL-TPS65033 Socketed
Programming Board. The BoosterPack enables pre-assembly programming for both the TPS650320-Q1 and the
TPS65033x-Q1 devices. The TPS65032001-Q1 and TPS65033000-Q1 are re-configurable PMICs for
prototyping various device settings. The settings can then be provided to TI for a final production PMIC.
Alternatively, the TPS65032001-Q1 and TPS65033000-Q1 devices can be programmed in production to match a
wide range of application requirements. The non-safety versions of the TPS650320-Q1 and TPS65033x-Q1 will
similarly allow programming of production units.
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1 BOOSTXL-TPS65033 Components and Environment
The TPS65032001-Q1 and TPS65033x-Q1 family of PMICs are configurable and programmable only through
I2C instructions. The BOOSTXL-TPS65033 socketed board is designed to act as a BoosterPack to the low cost
TI LaunchPads, enabling a LaunchPad to act as the USB-to-I2C interface for communication with a personal
computer. This separation reduces the cost of prototyping and enables experimentation with various TI devices,
including custom software development using existing LaunchPad tools. Many of these tools can be found online
at TI DevTools. The programming GUI is also available in the TI DevTools Gallery. This GUI is compatible with
both the MSP430F5529LP and the MSP432E401Y LaunchPads.

2 BOOSTXL-TPS65033 Board Information
The BOOSTXL-TPS65033 is designed to stack on top of a LaunchPad, connecting the relevant power and MCU
pins to the PMIC through the headers J1/J3 and J2/J4. Power is delivered to the PMIC from the USB port of a
PC through the the LaunchPad 5 V and 3.3 V rails. The following block diagram demonstrates how the
LaunchPad interfaces with the PC and the PMIC.
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Figure 2-1. Programming Board and LaunchPad Connections

2.1 Critical Socketed Board Connections
Critical connections for operating the socketed board are the 5 V rail, the 3.3 V rail, and the I2C pins. The
remaining connections to the LaunchPad are left available for future experimentation. Note: I2C pull-ups must be
pulled up to VIO. This can optionally be pulled up to 3.3 V (default) or an alternate rail through the J12.

By default, the 3.3 V rail must be present to power the VIO and GPIO pins to fully enable the PMIC. If evaluation
without a PC is desired, both the 5 V and the VIO domains should be externally supplied. If VIO is supplied by a
voltage other than 3.3 V, J12 should be left open to prevent potential current paths to the MCU 3.3 V. For most
configurations, the PMIC can supply VIO when externally connected to an appropriate test point, for example the
Buck 1 output if configured for 3.3 V, or the Buck 2 output if configured for 1.8 V.
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2.1.1 Power Switches

Both the 5 V and 3.3 V rails connect to the PMIC through separate current limiting load switches. The load
switches are simultaneously enabled with the S2 toggle switch on the top left area of the board. See Section 5
for the complete BOOSTXL-TPS65033 schematic. It is recommended to keep S2 open when connecting the
LaunchPad to the PC to reduce the initial current draw from the USB port.

2.2 Jumpers and Test Points

Figure 2-2. Programming Board Test Points and Jumpers
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3 Programming GUI Operation
3.1 Initial Set-up
3.1.1 Finding the GUI

The Graphical User Interface (GUI) for the BOOSTXL-TPS65033 can be found in the Gallery at TI DevTools.
This GUI will connect to the BOOSXL-TPS65033 provided a compatible I2C controller is connected
(MSP430F5529LP, MSP432E401Y, or USB2ANY). This GUI is also compatible with the TPS650320Q1EVM and
TPS650330Q1EVM, which both have on-board MSP432E401Y MCUs.

The GUI can be operated through Google Chrome™ or Mozilla Firefox™ web browsers. To run the GUI in the
browser, click the thumbnail and follow the prompted instructions for first time installation. The GUI requires both
a browser plugin and the TI Cloud Agent software for access to the local USB ports. The GUI can also be
downloaded for offline operation by hovering over the downward arrow in the GUI thumbnail and selecting the
desired platform – Windows®, macOS®, or Linux®.

3.1.2 Offline Installation

To download the offline installer, click the downward arrow on the below the thumbnail and select the relevant
operating system for the destination PC.

Figure 3-1. Standalone Installer Download Icon

The platform downloads will include the GUI Composer runtime installer if internet access is available during
installation. If the PC has no internet access at time of installation, the runtime installer may need to be
downloaded in advance using the additional links below the platform installation URLs.

Figure 3-2. Standalone Installer Operating System Options
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3.1.3 Flashing the MSP430F5529 LaunchPad

Initial operation with the MSP430F5529 LaunchPad requires downloading pre-configured firmware into the
MSP430 in order to be recognized by the GUI.

The GUI incorporates a tool to flash the MSP430F5529 LaunchPad, located under the File tab in the top menu.
This tool is pre-configured to flash the MSP430F5529LP only, and cannot be used with other LaunchPads.

Figure 3-3. LaunchPad Firmware Flashing Tool

To flash the LaunchPad, first connect the MSP430F5529LP to the PC using a micro-USB cable, then select File
> Program Device. The GUI will automatically download the firmware, recognize the LaunchPad, and flash the
board.

Afterwards the LaunchPad will be recognized as the specific USB-to-I2C interface for operating with the
TPS65032001-Q1 and TPS65033x-Q1 PMICs.

3.1.4 Flashing the MSP432E401Y Launch Pad

Initial operation with the MSP432E401Y LaunchPad requires downloading pre-configured firmware into the
MSP432 in order to be recognized by the GUI. See Section 3.1.2 about how this firmware must be accessed by
installing the GUI for offline operation.

1. Once downloaded, the MSP432 firmware file, acctrl_4_18.bin, can be found at:{Installation
Directory}\install_image_TPS6503xx-Q1_GUI.zip\TPS6503xx-Q1_GUI\app\firmware

2. Install UniFlash, a free firmware flashing tool from TI.
3. Connect the LaunchPad to the PC. Use the USB port on the MSP432E401Y LaunchPad that is opposite the

Ethernet port.
4. Run UniFlash. The program should automatically detect the connected MSP432E401Y LaunchPad. Once

detected, click Start.
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Figure 3-4. UniFlash Initial Setup
5. On the next page, browse to the binary file downloaded in Step 1 and click Load Image.

Figure 3-5. UniFlash Load Firmware Image
6. If prompted, update the XDS110 Debugger firmware. After accepting the update, UniFlash will update the

firmware automatically and continue to load the binary image. The console will indicate a successful program.
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Figure 3-6. UniFlash Successful Program
7. Unplug the micro USB cable from the MSP432E401Y LaunchPad.
8. Now plug the USB cable in to the micro USB port adjacent to the Ethernet port.
9. Install jumper on pins 3-4 (USB-OTG) of JP1 to supply the target 5 V supply through USB.

After completing this process, the GUI will recognize the LaunchPad as a USB-to-I2C interface. Next, stack the
BOOSTXL-TPS65033 on top of the MSP432E401Y LaunchPad. The headers should align according to Table
3-1.

Table 3-1. BoosterPack to MSP432E401Y LaunchPad Connections
BOOSTXL-TPS65033 Pin Header MSP432E401Y LaunchPad Pin Header

J1 J5

J2 J6

J3 J7

J4 J8

Note there may be two separate interfaces (or COM ports) recognized by the GUI. If one is failing to connect,
use the GUI to switch to an alternate port.

1. Click the Options menu at the top of the GUI, select Serial Port.

Figure 3-7. Serial Port Options
2. Use the Ports dropdown to select the alternative interface.
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Figure 3-8. GUI Serial Port Selection
3. The GUI will indicate a successful connection through the black connection toolbar.

Figure 3-9. Hardware Connected Indicator

3.2 Connection Debugging
The connection link in the black toolbar at the bottom of the GUI can be toggled to refresh the connection to the
LaunchPad. The flow chart in Figure 3-11 can aid in debugging potential connection issues with the BOOSTXL-
TPS65033.

Figure 3-10. Refreshing the GUI-to-MCU Connection
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Figure 3-11. BOOSTXL-TPS65033 Connection Debug Flow Chart

3.3 Basic Operation of the GUI
The GUI displays a README.md prompt each time the GUI is launched. The prompt can be disabled for
subsequent sessions by selecting the I checkbox at the bottom of the window. The README.md information is
always available in the Help tab at the top of the GUI.

The GUI automatically attempts to connect to the flashed LaunchPad, with the connection status displayed in the
bottom left hand corner of the GUI window. Once connected to the LaunchPad, the GUI attempts to read the
register information of the PMIC populated in the socket. If the PMIC appears unresponsive, verify the serial port
connection and confirm that all relevant shunts are populated according to Figure 2-2. If all shunts are populated
properly, pressing the RST button on the LaunchPad (S3) below the socketed board can often recover USB
communication.

3.3.1 Home

The Home section is the landing page of the GUI. Here the GUI presents an overview of the EVM and
Programming BoosterPack (BOOSTXL-TPS65033), and emphasize navigation to the remaining four sections
through the tiles on the bottom of the page.
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Figure 3-12. TPS6503xx-Q1 GUI Home Screen

3.3.2 Block Diagram

The Block Diagram section displays the typical components and functional blocks of the PMIC. A block diagram
for the Programming BoosterPack is also shown.

Figure 3-13. TPS6503xx-Q1 GUI Block Diagram Page

3.3.3 Registers

The Registers section provides an overview of the internal register map, and includes basic interfaces for each
PMIC register. Figure 3-14 illustrates the register page and the primary interactive regions.
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Figure 3-14. Register Page Interfaces

The register table displays each register name, address, last known value from the PMIC, and corresponding bit
values. Selecting a title or bit fields in the table will update the Field View column on the right side of the GUI.
The Field View displays the individual fields contained within the associated register address. Within the register
page, clicking a blue icon containing a question mark (?) will expand additional descriptions if available. The
expanded description views can then be closed by clicking the red (x) icon.

This register page can poll the device periodically using the Auto Read feature in the top right corner, or allow
manual read instructions using the Read Register and Read All Registers buttons.

A drop-down menu selection at the top right of the register map indicates how the registers are written as the
user interacts with the register page. With Immediate selected, any update to the register page is automatically
sent to the PMIC, whereas Deferred will wait for the Write Register or Write All Registers instructions before
communicating with the device. After each write, the register page will automatically read the affected register
address to confirm the latest value in the device.

3.3.4 Device Configuration

The Device Configuration section is organized into selectable tabs at the top of the page, where only the
contents of the blue tab is actively displayed. Each tab contains categorized visual instruments relating to
individual bit fields within the register map. Each instrument is linked to the latest bit values in the register map
table, and can be used to alter settings within the PMIC through the dropdown menus or check box features. If
the Auto Read function in the register map is inactive, the Read All Registers button in the top right area of the
Device Configuration page can be used to manually refresh the register page, which will then update the
instruments with the latest device values.

The PMIC incorporates Control Lock and Configuration Lock features that can prevent I2C writes to various
registers within the device. The status of these locks will always be displayed in the top right hand corner of the
Device Configurations page, and can be toggled by clicking their associated checkbox. When the GUI is properly
connected to the EVM and write instructions appear to be ignored by the PMIC, confirm the status of these
indicators to verify the device is able to accept new write instructions.
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Figure 3-15. TPS6503xx-Q1 GUI Device Configuration Page

3.3.4.1 Using Device Configuration to Define Spin Settings

In some circumstances, TI may provide customized, pre-programmed devices for the camera application.
Contact a local TI sales representative for more information.

The Device Configuration tabs in the GUI can be used to define custom settings for TI to pre-program into the
device Non-Volatile Memory (NVM). Before beginning the spin definition, see the Camera PMIC Spin Selection
Guide to determine if there is an exisiting spin that is already compatible with the target application and the
image sensor or both.

Since the visual instruments in the Device Configuration page link directly to the corresponding bits and registers
in the Register Map page, the Device Configuration page can be used to quickly define desired OTP register
settings.

1. Select the desired camera PMIC from the drop-down menu above the tab indicators to start. The GUI will
automatically show, hide, or disable features corresponding to the selected PMIC. This drop down box will not
be adjustable if a device is connected to the GUI.
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Figure 3-16. Device Selection for Generating NVM Settings
2. Select the desired regulator, sequencing, and additional feature settings in each of the tabs. These changes

will be reflected in the Register Map page. For determining the power sequence settings, see Section 3.3.4.2.
3. Click File > Save Settings in the top left corner of the GUI. This exports the register settings in a JSON file

that is provided to generate the NVM spin.

Figure 3-17. Example Settings Output

3.3.4.2 Configuring the Power Sequence

The Sequencing Overview tab includes instruments to customize the power sequence of the PMIC. Note that the
check boxes are power sequence masks. If a particular logic signal needs to be included as part of the regulator
or logic power up sequence, leave the box next to the logic signal unchecked. TI recommends to set Power On
Bit unmasked for each rail that is required in the application.
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Figure 3-18. Sequencing Overview Tab

When using a TPS65033x-Q1 device, the GPIO pin can also be used for power sequencing of an external
regulator or other device. In the Special Features tab, configure GPIO as an output to include its sequencing in
the Sequencing Overview tab. Note that when using GPIO for sequencing, the GPIO Function must be Enabled.

Figure 3-19. Sequencing Overview Including GPIO

For reference, the GUI can generate example power-up and power-down timing diagrams based on the
sequence settings present when the UPDATE TIMING DIAGRAM button is clicked. As noted, rise and fall times
are approximate, and the maximum sequence length is 200 ms. Changes to regulator enable and output
discharge settings are reflected in the timing diagram. If the sequence settings are not valid, the GUI will provide
a notifying message and the timing diagram will not be updated. For example, if a regulator is enabled but fails
to power-up within 200 ms, the sequence settings are not valid.
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Figure 3-20. GUI Generated Timing Diagram

3.4 Scripting
The GUI includes a scripting feature in the tools menu at the top of the window. Scripting enables automated
writes and reads to the PMIC, allowing sequential instructions to be sent to the PMIC. Scripts can be saved as
a .js or .txt file, and imported using the Upload arrow at the top of the scripting window. Scripting allows the re-
configuration of multiple PMICs before sending to assembly or populating on a PCB.

Figure 3-21. TPS6503xx-Q1 GUI Scripting Window
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An example script for re-programming a device can be seen below, where output voltages and sequencing
settings are reconfigured from the default settings.

/* Entry point for the script, which will be executed when the user presses the PLAY button in the 
Scripting Dialog. */
function main() {
write('CONTROL_LOCK', 0xDD);     // Unlock control registers
write('CONFIG_LOCK', 0xAA);      // Unlock configuration registers
write('GPIO_CTRL',2);            // Disable configuration CRC
write('BUCK_LDO_CTRL',0x00);     // Turn off all regulators to prevent faults
write('BUCK3_VOUT',6);           // Change Buck 3 output voltage
write('LDO_VOUT',8);             // Change LDO output voltage
write('SEQ_TRIG_BUCK2',10);      // Update Buck 2 sequence dependencies
write('SEQ_TRIG_BUCK3',2);       // Update Buck 3 sequence dependencies
write('SEQ_TRIG_LDO',26);        // Update LDO sequence dependencies
write('SEQ_TRIG_nRSTOUT',2);     // Update nRSTOUT sequence dependencies
write('BUCK1_SEQ_DLY',145);      // Update Buck 1 sequence delay
write('BUCK2_SEQ_DLY',86);       // Update Buck 2 sequence delay
write('BUCK3_SEQ_DLY',54);       // Update Buck 3 sequence delay
write('LDO_SEQ_DLY',118);        // Update LDO sequence delay
write('nRSTOUT_SEQ_DLY',6);      // Update nRSTOUT sequence delay
write('BUCK_LDO_CTRL',31);       // Re-enable all regulators
write('EEPROM_PROG_CMD',45);     // Burn settings into EEPROM
}

Figure 3-22 details the typical device programming flow. Most blocks can be executed with one or more register
write commands in the script file. Only the J2 configuration and GPIO trigger application cannot be done via
scripting.
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Figure 3-22. Example Script Program Flow
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4 Recommended Operating Procedure

• Due to the parasitic elements introduced by the BOOSTXL-TPS65033 socket, it is recommended
to use the BOOSTXL-TPS65033 board primarily for digital evaluation. This includes features like
NVM programming, state machine behavior, diagnostics, and fault handling.

• For analog performance evaluation of the PMIC, please refer to the TPS650320-Q1 EVM and the
TPS650330-Q1 EVM.

1. Connect the socketed board to the MSP430F5529 LaunchPad by aligning placing the socketed board on top
of the LaunchPad, aligning the J1/J3 and J2/J4 headers, and pressing the two boards together. For the
MSP432E401Y, align with the J5/J7 and J6/J8 headers.

2. Ensure S1, S2, and S3 of the socketed board are not asserted (down position), and connect the LaunchPad
to the PC using a micro-USB cable. A TPS65032001-Q1 or TPS65033x-Q1 device may be inserted into the
socket at any time that S2 is open and proper ESD considerations are observed. Ensure the unit's Pin 1
indicator is aligned with the Pin 1 silkscreen indicator on the lower left corner of the socketed board.

3. Ensure the Device Selection jumper (J2) matches the generic part number of the device populated in the
socket.

4. If this is the first time using the LaunchPad with the TPS6503xx-Q1 GUI, flash the LaunchPad using the steps
outlined in Section 3.1.3 or Section 3.1.4. This will permanently configure the LaunchPad to act as a USB-to-
I2C adapter and will not be necessary for subsequent sessions.

5. Set S2 to the active position. The D1 LED will indicate when power is supplied to the socket.
6. Verify the connection status of the adapter in the bottom left corner of the GUI window. If Hardware not

Connected is displayed, toggle the connection icon once to refresh the adapter connection. With the D1 LED
active and the adapter recognized by the GUI, I2C communication should be available to the PMIC. The
adapter will disconnect if I2C communication fails. Verify that the I2C pull-up voltage is available (J12 and
VIO test point) if the GUI consistently disconnects after read or write attempts.

7. Navigate to the Register Map or Device Configuration page, and select the Read All Registers button in the
top right corner of the GUI window.

8. The Register Map will populate with the returned values as the PMIC replies to the I2C read requests. The
Register Map can directly interact with the PMIC through drop down menus for each register field or by
directly writing into the value column for the individual registers. For a graphical representation of common
device settings, select the slider icon below the pencil icon in the left toolbar to navigate to the Device
Configuration view. These visual indicators are linked directly to the respective bits or bitfields in the register
map.

9. Selecting the tabs at the top of the Device Configuration view will navigate through the categorized register
fields.

10.By default, the Control and Configuration registers of the PMIC are always locked after a re-start event,
preventing accidental I2C writes to the device. The check-boxes in the top right corner of the Device
Configuration view can verify if critical registers are accepting write instructions from the I2C master. These
check boxes can also be used to lock and unlock the associated registers.

11.By default, certain regulators are dependent on either the status of SEQ (S1), or the status of SEQ and GPIO
(S3). All sequencing dependencies are visible in the regulator's respective tab, or by using the Sequencing
Overview tab within the Device Configuration view.

12.When registers are unlocked, any changes to the device registers will take effect immediately.
13.The PMIC will always return to default settings if a fault occurs that forces a transition to the RESET state.
14.Register changes will not be stored in EEPROM unless the programming instruction has been sent to the

PMIC through the I2C.
15.The EEPROM is programmed when a hex value of 0x2D is written to register 0x4A. In the GUI, this can be

done directly through the register map or by clicking the Flash EEPROM button in the Re-Program PMIC
view of the GUI.
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5 BOOSTXL-TPS65033 Schematic
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6 BOOSTXL-TPS65033 Board Layers

Figure 6-1. Top Layer
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Figure 6-2. Mid-Layer 1

www.ti.com BOOSTXL-TPS65033 Board Layers

SLVUBO3A – APRIL 2019 – REVISED OCTOBER 2020
Submit Document Feedback

BOOSTXL-TPS65033 User's Guide 23

Copyright © 2020 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/feedbackform/techdocfeedback?litnum=SLVUBO3A&partnum=


Figure 6-3. Mid-Layer 2
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Figure 6-4. Bottom Layer (Mirrored)
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7 BOOSTXL-TPS65033 Bill of Materials
Table 7-1. BOOSTXL-TPS65033 Bill of Materials (BOM)

Designator Quantity Value Description Package Reference Part Number Manufacturer
!PCB1 1 Printed Circuit Board BMC059 Any

C1, C7 2 1 µF CAP, CERM, 1 µF, 35 V, ±
20%, X5R, 0402

0402 GRM155R6YA105ME1
1D

MuRata

C2 1 150 µF CAP, TA, 150 µF, 6.3 V, ±
20%, 0.025 Ω, SMD

3528-21 T520B157M006ATE025 Kemet

C3, C6 2 0.1 µF CAP, CERM, 0.1 µF, 10 V,
± 20%, X5R, 0402

0402 885012105010 Wurth Elektronik

C4, C5, C11,
C14

4 10 µF CAP, CERM, 10 µF, 10 V,
± 20%, X5R, 0402

0402 CL05A106MP5NUNC Samsung Electro-
Mechanics

C8 1 0.1 µF CAP, CERM, 0.1 µF, 50 V,
± 20%, X7R, AEC-Q200
Grade 1, 0402

0402 CGA2B3X7R1H104M0
50BB

TDK

C9, C12,
C13

3 10 µF CAP, CERM, 10 µF, 25 V,
± 20%, X7R, AEC-Q200
Grade 1, 1210

1210 CGA6P1X7R1E106M2
50AC

TDK

C10 1 10 µF CAP, CERM, 10 µF, 10 V,±
20%, X7R, AEC-Q200
Grade 1, 1206

1206 LMK316AB7106MLHT Taiyo Yuden

C15, C17 2 10 µF CAP, CERM, 10 µF, 6.3
V,± 10%, X7R, AEC-Q200
Grade 1, 0805

0805 JMJ212CB7106KGHT Taiyo Yuden

C16, C18,
C19, C20

4 1 µF CAP, CERM, 1 µF, 10 V, ±
10%, X7R, AEC-Q200
Grade 1, 0603

0603 LMK107B7105KAHT Taiyo Yuden

D1 1 Green LED, Green, SMD 0.8x1.6 mm HSMG-C190 Avago

H1 1 IC to place in Socket XU1 TPS650330QRGEQ1 Texas Instruments

J1 1 Header, 100 mil, 2x1, Tin,
TH

Header 2x1 90120-0122 Molex

J2 1 Header, 100 mil, 3x2, Tin,
TH

3x2 Header PEC03DAAN Sullins Connector
Solutions

J3, J4 2 Receptacle, 2.54 mm,
10x2, Tin, TH

10x2 Receptacle SSQ-110-03-T-D Samtec

J5, J12 2 Header, 100 mil, 2x1, Tin,
TH

Header, 2 PIN, 100 mil,
Tin

PEC02SAAN Sullins Connector
Solutions

J7, J9 2 Header, 100 mil, 3x1,
Gold, TH

PBC03SAAN PBC03SAAN Sullins Connector
Solutions

J11 1 Header, 100 mil, 4x2, Tin,
TH

Header, 4x2, 100 mil, Tin PEC04DAAN Sullins Connector
Solutions

L1 1 1.5 µH Inductor, Shielded, Metal
Composite, 1.5 µH, 2.3 A,
0.11 Ω, AEC-Q200 Grade
0, SMD

0806 TFM201610ALMA1R5
MTAA

TDK

L3, L4 2 1 µH Inductor, 1 µH, 3.1 A, 0.06
Ω, SMD

2.0x1.6x1.0 mm TFM201610GHM-1R0
MTAA

TDK

Q1 1 25 V MOSFET, N-CH, 25 V, 5
A, DQK0006C (WSON-6)

DQK0006C CSD16301Q2 Texas Instruments

R1, R2 2 100 k RES, 100 k, 5%, 0.1 W,
AEC-Q200 Grade 0, 0603

0603 CRCW0603100KJNEA Vishay-Dale

R3 1 1.5 k RES, 1.5 k, 5%, 0.063 W,
AEC-Q200 Grade 0, 0402

0402 CRCW04021K50JNED Vishay-Dale

R4 1 680 RES, 680, 5%, 0.1 W,
0603

0603 RC0603JR-07680RL Yageo

R5, R6 2 4.7k RES, 4.7 k, 5%, 0.1 W,
0603

0603 RC0603JR-074K7L Yageo
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Table 7-1. BOOSTXL-TPS65033 Bill of Materials (BOM) (continued)
Designator Quantity Value Description Package Reference Part Number Manufacturer
R7, R8, R9 3 0 RES, 0, 5%, 0.063 W,

0402
0402 RC0402JR-070RL Yageo America

S1, S3 2 Switch, Slide, SPDT, On-
Off-On, 3 Pos, 0.05 A, 48
V, TH

9.5x5 mm AS1E-2M-10-Z Copal Electronics

S2 1 Switch, Slide, SPDT, 0.2
A, J Lead, SMD

SMD, 3-Leads, Body
8.5x3.5 mm, Pitch 2.5 mm

CL-SB-12A-01T Copal Electronics

SH-J1, SH-
J2, SH-J3,
SH-J4, SH-
J5, SH-J6,
SH-J7, SH-
J8

8 1x2 Shunt, 100 mil, Flash
Gold, Black

Closed Top 100 mil Shunt SPC02SYAN Sullins Connector
Solutions

TP1, TP2,
TP3, TP4,
TP5, TP6,
TP7, TP8,
TP9, TP10,
TP11, TP12,
TP13, TP14,
TP15, TP16,
TP17, TP18

18 PCB Pin, Swage Mount,
TH

PCB Pin(2505-2) 2505-2-00-44-00-00-07-
0

mill-Max

U1, U2 2 5.5 V, 2 A, 38 mΩ Load
Switch With Quick Output
Discharge, YFP0004AAAA
(DSBGA-4)

YFP0004AAAA TPS22915CYFPR Texas Instruments

XU1 1 Socket, QFN-24, 0.5 mm
Pitch

Socket, QFN-24, 0.5 mm
Pitch

QFN-24BT-0.5-01-00 Enplas Tech Solutions
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STANDARD TERMS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or

documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License

Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING
Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers

and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI’s recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI’s recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI’s instructions for

electrical ratings of interface circuits such as input, output and
electrical loads.

NOTE:
EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

http://www.ti.com
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Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

http://www.ti.com
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
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4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

http://www.ti.com
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8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated

http://www.ti.com


IMPORTANT NOTICE AND DISCLAIMER
TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you
permission to use these resources only for development of an application that uses the TI products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third party
intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims, damages,
costs, losses, and liabilities arising out of your use of these resources.
TI’s products are provided subject to TI’s Terms of Sale (https:www.ti.com/legal/termsofsale.html) or other applicable terms available either
on ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s
applicable warranties or warranty disclaimers for TI products.IMPORTANT NOTICE

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2021, Texas Instruments Incorporated

https://www.ti.com/legal/termsofsale.html
https://www.ti.com
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